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LISTE DES ABREVIATIONS UTILISEES 

Abréviation Description 

FC Fonds de cohésion 

DG REGIO Direction générale de la politique régionale et urbaine 

CE Commission européenne 

FEDER Fonds européen de développement régional 

UE Union européenne 

RH  Ressources humaines 
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GLOSSAIRE DES TERMES  

Terme Description 

Compétence 

Capacité d’appliquer ou d’utiliser des connaissances, des 

aptitudes, des capacités, des comportements et des 

caractéristiques personnelles pour mener à bien des tâches 

essentielles, exécuter des fonctions spécifiques ou assumer un 
rôle ou une position donnés. 

Référentiel de 

compétences 

Instrument utilisé pour gérer les ressources humaines, 

incluant des séries de compétences pertinentes pour le 

développement des organisations et des employés. 

Employés du niveau 

décisionnel (décideurs) 

Personnes se trouvant à la tête de l’institution du FEDER/du 

Fonds de cohésion ou agissant à des niveaux de gestion 

stratégique relativement élevés. 

Référentiel de 

compétences de l’UE 

Référentiel de compétences établi par la DG REGIO pour le 

FEDER et le Fonds de cohésion. 

Groupes de rôles 

Les trois types de rôles assumés par les employés participant 

à la gestion et à la mise en œuvre du FEDER/FC (employés du 

niveau opérationnel, employés du niveau de la supervision et 

employés du niveau décisionnel), définis en tenant compte 

des tâches, des sous-tâches et des responsabilités attribuées 

à chaque niveau. 

Équipe de mise en 

œuvre 

L’équipe, au sein d’une administration, qui est responsable de 

la réalisation d’une évaluation des compétences à l’aide du 

référentiel de compétences de l’UE et de l’outil 

d’autoévaluation.  

Institution 

Types d’institutions participant à la gestion et la mise en 

œuvre du FEDER et du FC conformément aux règlements: 

fonctions d'organisme de coordination, d'autorité de gestion, 

d'autorité de certification, d'organisme intermédiaire, 

d'autorité d’audit ou de secrétariat conjoint. 

Instruments Référentiel de compétences de l’UE et outil d’autoévaluation 

Description de poste 

Document résumant les principales responsabilités, fonctions 

et tâches, ainsi que les compétences et les niveaux de 

maîtrise exigés. 

Compétences de gestion 
Compétences relatives à une fonction de gestion et basées sur 

l’acquisition de connaissances, d’aptitudes et de capacités. 

Compétences 

opérationnelles 

Compétences que doit posséder le personnel pour gérer 

efficacement les fonctions qui lui ont été confiées en ce qui 

concerne la gestion du FEDER et du FC. 

Employés du niveau 

opérationnel 

Ce sont les experts qui travaillent directement sur les 

différentes tâches et sous-tâches établies au sein de 

l’organisation. 

Compétences 

professionnelles 

Compétences requises pour l’exécution de fonctions 

professionnelles spécifiques et basées sur des connaissances, 

des capacités et des aptitudes acquises. 

Règlements 
Règlements pour les Fonds structurels et d’investissement 

européens 2014-2020. 
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Terme Description 

Automatisation 

robotisée des processus 

Application d’une technologie permettant de configurer un 

logiciel informatique ou un «robot» pour capturer et 

interpréter des applications existantes afin de traiter une 

transaction, de manipuler des données, de déclencher des 

réponses et de communiquer avec d’autres systèmes 

numériques. 

Autoévaluation 

Évaluation par un individu de son propre niveau de maîtrise 

des compétences requises pour l’exécution efficace et 

efficiente des tâches qui lui ont été attribuées. 

Outil d’autoévaluation 

(outil) 

Outil en ligne utilisé pour évaluer le niveau de maîtrise des 

compétences de l’utilisateur et déterminer les compétences à 

améliorer. 

Sous-tâche 
Action exécutée par une autorité (institution) ou une personne 

produisant un résultat lié à la gestion du FEDER et du FC. 

Employés du niveau de 

la supervision 

(superviseurs) 

Il s’agit des employés du niveau d’encadrement intermédiaire 

des institutions du FEDER/FC; il s’agit généralement des chefs 

des unités organisationnelles, responsables d’un groupe de 

personnes, qui ne participent pas directement à la mise en 

œuvre opérationnelle du programme. 

Tâches 

Groupe de sous-tâches regroupées en fonction d’une même 

finalité et exécutées par une personne ou un groupe de 

personnes dans le cadre de leurs activités quotidiennes en 

vue d’assurer la gestion du FEDER et du FC. 

Plans d’apprentissage et 

de développement 

Plans de développement des compétences basés sur les 

résultats d’une évaluation des compétences réalisée à l’aide 

du référentiel de compétences de l’UE et de l’outil 

d’autoévaluation. 
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 INTRODUCTION 1

Le présent guide de l’utilisateur a été élaboré par la DG Politique régionale et urbaine 

(DG REGIO) de la Commission européenne afin d’aider les administrations participant à 
la gestion et la mise en œuvre du FEDER et du Fonds de cohésion à mettre en œuvre le 

référentiel de compétences de l’UE et l’outil d’autoévaluation (ci-après les 
«instruments»). 

Ce guide constitue le principal document d’orientation pour la mise en œuvre des 
instruments au niveau des administrations. Il est recommandé de le faire lire 

attentivement par les employés de l’administration qui seront chargés de la mise en 

œuvre des instruments avant le début de l’évaluation des compétences.  

Le guide de l’utilisateur porte sur les points suivants: 

 le référentiel de compétences de l’UE détaillant les compétences requises pour la 

gestion et la mise en œuvre du FEDER et du Fonds de cohésion, sa raison d’être et 

ses avantages (chapitre 2); 

 l’outil d’autoévaluation, qui rassemble tous les éléments du référentiel de 

compétences de l’UE en un instrument permettant l’autoévaluation des compétences 

des employés et des institutions (chapitre 2); 

 l’organisation du processus d’évaluation des compétences, c'est-à-dire la séquence 

des étapes et des activités qui le composent ainsi que les recommandations sur ce 

que les institutions devraient ou ne devraient pas faire lors de la mise en œuvre des 

instruments (chapitre 3); 

 la préparation des plans d’apprentissage et de développement (et de leur modèle) 

afin d’améliorer les compétences à renforcer, y compris un cadre méthodologique 

pour la sélection des possibilités d’apprentissage les plus pertinentes (chapitre 3); 

 des instructions techniques décrivant les étapes à suivre pour modifier le référentiel 

de compétences de l’UE et l’outil d’autoévaluation (chapitre 4). 

Les liens entre ces contenus sont présentés dans l’illustration ci-dessous: 
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Pour commencer, les administrations devraient:  

 se procurer un exemplaire de l’outil d’autoévaluation en envoyant une demande de nom 

d’utilisateur et de mot de passe à l’adresse REGIO-COMPETENCY-

FRAMEWORK@ec.europa.eu, et 

 utiliser le nom d’utilisateur et le mot de passe sur le site web suivant, qui héberge 

l’outil d’autoévaluation:  

 https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools 

 

 

 

mailto:REGIO-COMPETENCY-FRAMEWORK@ec.europa.eu
mailto:REGIO-COMPETENCY-FRAMEWORK@ec.europa.eu
https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools
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 RAISON D’ÊTRE ET CONCEPTS CLÉS 2

 Pourquoi un référentiel de compétences de l’UE et un outil 2.1

d’autoévaluation? 

À mesure que la politique de cohésion a évolué avec le temps, l’étendue des savoir-faire 
et des compétences nécessaires à sa mise en œuvre a pris de l’ampleur. C’est pourquoi 

la Commission a décidé d’accorder, en adoptant des mesures concrètes, une importance 
accrue au soutien des États membres dans leurs efforts visant à renforcer la capacité 

administrative des administrations nationales et régionales qui gèrent le FEDER et le 
Fonds de cohésion.  

Au cours de la période de programmation 2014-2020, des modifications ont été 

apportées aux règlements, ce qui a rendu nécessaires de nouvelles compétences pour la 
gestion et la mise en œuvre du FEDER et du Fonds de cohésion. En outre, une gestion 

efficace des Fonds requiert une gamme de compétences dépassant le cadre des 
exigences établies dans les règlements.  

Pour relever ces défis, la Commission a conçu le référentiel de compétences de l’UE et 
l’outil d’autoévaluation en tant qu'«instruments» pratiques pour aider les administrations 

à renforcer leur capacité de gestion et de mise en œuvre du FEDER et du Fonds de 
cohésion:  

 le référentiel de compétences de l’UE est un instrument destiné à la gestion des 

ressources humaines. Il définit les compétences nécessaires à l’évolution des 

employés et des institutions participant à la gestion et la mise en œuvre du FEDER et 

du FC.  

 L’outil d’autoévaluation est basé sur le contenu du référentiel de compétences de 

l’UE. Il sert à évaluer le niveau de maîtrise des compétences des employés et des 

institutions et fournit des éléments factuels pour élaborer des mesures de 

développement des compétences. 

Les principaux avantages de ces instruments sont: 

 des instruments de renforcement des capacités adaptés aux spécificités du FEDER 

et du Fonds de cohésion; 

 la possibilité pour les administrations de mener une réflexion sur leur niveau de 

compétence, tant au niveau des employés qu’au niveau de l’institution; 

 une source d’informations destinée aux gestionnaires des institutions sur les besoins de 

développement des compétences; 

 des éléments factuels qui pourront servir à élaborer des stratégies répondant aux besoins 

de développement des compétences, notamment une utilisation plus stratégique de 

l’assistance technique des fonds ESI; 

 une source de réflexion sur les améliorations pouvant être apportées à la structure 

organisationnelle de l’administration en ce qui concerne les fonctions relatives au 

FEDER et au FC; 

 une discussion facilitée entre les employés et les superviseurs au sujet du savoir-

faire et de la capacité des employés ainsi que de leurs forces et faiblesses; 

 aucune exigence en matière de compétences techniques ou de coûts pour les 

administrations. 

L’utilisation des instruments n’est pas obligatoire et les résultats de l’autoévaluation sont 

destinés à l’usage exclusif des institutions, il n'est pas prévu qu'ils servent à alimenter 
les rapports soumis à la Commission. Dans le même ordre d’idées, lorsque les 
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instruments sont mis en œuvre au sein d’une institution, il est recommandé que leur 

utilisation soit distincte des processus d’appréciation et que les résultats des évaluations 
des employés soient traités avec confidentialité. 

 Concepts clés et définitions 2.2

Le référentiel de compétences de l’UE 

Le référentiel de compétences de l’UE définit les compétences nécessaires à l’évolution 

des employés et des institutions participant à la gestion et la mise en œuvre du FEDER 
et du FC. Il concerne l’organisme de coordination, l’autorité de gestion et l’organisme 

intermédiaire, le secrétariat conjoint, l’autorité de certification et l’autorité d’audit. Le 

graphique ci-dessous donne un aperçu du contenu du référentiel de compétences de 
l’UE:  

 

Concrètement, le contenu du référentiel de compétences de l’UE est réparti en plusieurs 
fichiers Excel distincts (un par type d'institution). La version actuelle du référentiel de 

compétences de l’UE est incluse à l’ANNEXE 1: RÉFÉRENTIEL DE COMPÉTENCES DE L’UE 
et un extrait de son contenu est présenté dans le graphique ci-dessous: 

 

Pour chaque type d’institution, le référentiel de compétences de l’UE comprend: 

 des tâches et des sous-tâches: celles-ci sont définies en tenant compte des 

règlements des fonds ESI pour la période 2014-2020, des dispositions juridiques 

Tâches 5

Sous-tâches 20

Compétences de gestion 12

Autorité de 
gestion et 
organisme 

intermédiair
e

Autorité de 
certification 

Organisme 
de 

coordination

Autorité 
d’audit

10

47

2

13

1

10

Compétences opérationnelles 35 44 18 18

Compétences professionnelles 12

Échelles de maîtrise
1 échelle: de 0 à 4 pour les compétences opérationnelles, professionnelles et de 
gestion

Groupes de rôles professionnels 3 groupes: niveau décisionnel, niveau de la supervision, niveau opérationnel

Secrétariat 
conjoint

9

37

44
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nationales et des exemples de bonnes pratiques tirés de l’expérience des différents 

États membres. 

 des groupes de rôles professionnels: on distingue trois groupes de rôles 

professionnels, à savoir les décideurs (généralement le directeur de l’institution 

FEDER/FC), les superviseurs (par exemple les chefs d’unités organisationnelles) et 

les employés du niveau opérationnel, qui ont eux-mêmes différents niveaux 

d’ancienneté; 

 des groupes de compétences: on dénombre trois groupes de compétences, à 

savoir les compétences de gestion, les compétences professionnelles et les 

compétences opérationnelles, qui sont en rapport avec les tâches et sous-tâches 

exécutées par les différents employés en fonction de leur rôle professionnel; 

 les compétences opérationnelles sont celles qui sont requises pour exécuter 

les fonctions attribuées au titre des règlements (par exemple celles en rapport 

avec les options simplifiées en matière de coûts et les aides d’État);  

 les compétences professionnelles sont nécessaires à la bonne exécution de 

certaines fonctions professionnelles spécifiques (par exemple gestion des conflits 

ou résolution des problèmes);  

 les compétences de gestion sont celles que doivent posséder les employés 

investis de fonctions de gestion et, dans une certaine mesure, les employés 

opérationnels (par exemple délégation ou capacités d'encadrement). 

 Niveau de maîtrise: une échelle de maîtrise de 0 à 4 est associée à chaque 

compétence. Les niveaux de maîtrise des compétences inclus dans le référentiel de 

compétences de l’UE représentent l’objectif de développement des compétences des 

employés et des institutions à moyen terme.  

L’outil d’autoévaluation 

L’outil d’autoévaluation est un outil en ligne dont l’utilisation ne nécessite aucune 
exigence technique, si ce n’est un accès à l’internet et un navigateur internet (comme 

Explorer ou Google Chrome). 

Basé sur le référentiel de compétences de l’UE, son but est d’évaluer les compétences 

des différents employés et institutions, de déterminer celles qui font défaut ou qui 

doivent être améliorées et de fournir des éléments factuels pour la conception et la mise 
en œuvre de plans d’apprentissage et de développement pour l’institution et les 

différents employés.  

Les grandes étapes fonctionnelles de l’outil sont les suivantes: 

 

L’outil d’autoévaluation présente un niveau élevé de flexibilité permettant d’effectuer des 
évaluations personnalisées, basées sur les tâches et sous-tâches exécutées par une 

autorité donnée:   

 l’outil permet aux employés de sélectionner leur rôle, leurs tâches et leurs sous-

tâches; puis, en fonction de cette sélection, l'outil dresse la liste des compétences à 

évaluer sur la base du référentiel de compétences de l’UE, ce qui permet de réaliser 

une évaluation personnalisée de l’employé.  
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 Le superviseur de l’employé (ou le décideur, lorsque l’autoévaluation est réalisée par 

un superviseur) procède ensuite à une évaluation indépendante des compétences de 

ce dernier. L’intervention d’une deuxième personne dans l’évaluation permet de 

contrôler la note d’autoévaluation et de l’ajuster en fonction de l’appréciation du 

superviseur.  

 L’employé et le superviseur se rencontrent ensuite afin de discuter des résultats 

calculés par le système, qui comprennent, pour chaque compétence évaluée, 

l’autoévaluation de l’employé, l’évaluation du superviseur et le niveau de maîtrise 

fondé sur le référentiel de compétences de l’UE. Lors de cette réunion, l’employé et 

son superviseur abordent toute éventuelle incohérence, apportent au besoin des 

adaptations à l’évaluation du superviseur et conviennent d’actions de suivi.   

 Les résultats de chaque autoévaluation sont enregistrés dans l’outil et peuvent être 

utilisés à des fins d’analyse au niveau de l’institution. Cet outil en ligne permet de 

choisir entre deux possibilités pour effectuer l’analyse des données: utiliser les 

fonctions intégrées pour analyser les différentes compétences ou se servir des 

modèles Excel semi-automatisés pour disposer d'un aperçu de l’ensemble des 

compétences de l’institution. 
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 COMMENT UTILISER LES INSTRUMENTS 3

L’utilisation du référentiel de compétences de l’UE et de l’outil d’autoévaluation nécessite 

la mise en place d’un processus d’évaluation des compétences au sein de l’institution. 
Les sections suivantes proposeront des orientations sur la manière dont ce processus 

peut être organisé (phases, activités, étapes) ainsi que sur la manière dont les 
instruments, en particulier l’outil d’autoévaluation, doivent être utilisés. Le graphique ci-

dessous illustre les phases et les activités de l’évaluation des compétences: 

 

 Phase 1: mise en place de l’évaluation 3.1

Activité 1.1: désignation de l’équipe de mise en œuvre 

L’équipe nécessaire à la coordination et à la mise en œuvre de l’évaluation des 

compétences devra être restreinte. Trois différents rôles sont indiqués (bien que, dans 
les institutions de plus petite taille, davantage de rôles pourraient être attribués à un 

même employé). Ces rôles sont les suivants: 

 Coordinateur: le chef de l’institution (ou son adjoint) doit assumer la responsabilité 

globale de la réalisation de l’évaluation des compétences et des actions de suivi. 

 Gestionnaire: un superviseur appartenant à l’institution du FEDER/du Fonds de 

cohésion, responsable de la mise en œuvre quotidienne des instruments. Il est 

également recommandé d’attribuer au gestionnaire les droits d’utilisateur relatifs à la 

gestion de l’outil d’autoévaluation. 

 Gestionnaire des ressources humaines (RH): en fonction de la structure 

institutionnelle, un gestionnaire du service des ressources humaines pourrait 

participer à l’évaluation.  

Activité 1.2: formation de l’équipe de mise en œuvre 

Le gestionnaire et le gestionnaire des RH devraient se familiariser avec les instruments 

 en prenant connaissance du contenu du référentiel de compétences de l’UE; 

 en testant le fonctionnement de l’outil d’autoévaluation et des modèles d’analyse; 

1

2

Formation et 
communication

Autoévaluation par les 
employés

Évaluation par le 
superviseur

3

5Rapports 
individuels

1Préparation des 
analyses

3Discussion en 
atelier

Plan 
d’apprentissage 
et de 
développement

4

DÉPLOIEMENT DE 
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ANALYSE ET PRÉPARATION 
DES PLANS D’A&D

Réunion de 
discussion

4

2
Hiérarchisation 
des actions
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L’ÉVALUATION
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et responsabilités

Formation de 
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2
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1

Préparation des 
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formation et de 
communication 

4
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 en assistant aux formations et aux séminaires en ligne susceptibles d’être organisés 

par la Commission. 

Activité 1.3: détermination de la participation des employés et 

personnalisations éventuelles 

L’équipe de mise en œuvre définit la portée de l’évaluation en ce qui concerne la 
participation des employés, la personnalisation éventuelle des instruments et le degré 

d’orientation à fournir. En ce qui concerne la participation des employés, il est 
recommandé: 

 de faire participer tous les employés du niveau opérationnel à la réalisation de leur 

autoévaluation;  

 de faire participer tous les employés du niveau de la supervision à la réalisation de 

leur autoévaluation ainsi qu’à l’évaluation des compétences des employés de leur 

unité organisationnelle; 

 de faire participer le ou les décideurs à l’évaluation des superviseurs et de leur faire 

réaliser une autoévaluation. 

En ce qui concerne la personnalisation: 

 même s’il est possible de le faire, il est recommandé de ne pas modifier les tâches, 

sous-tâches, compétences et niveaux de maîtrise des compétences établis par le 

référentiel de compétences de l’UE et l’outil d’autoévaluation, du moins lors de la 

première utilisation des instruments. 

Pour les tâches, sous-tâches et compétences: 

 lorsqu’un élément n’est plus jugé pertinent pour l’institution, il peut être 

demandé aux employés de ne pas le sélectionner. À défaut, comme expliqué au 

chapitre 4, il est possible de supprimer l’élément du référentiel de compétences de 

l’UE dans un premier temps, puis, dans un deuxième temps, de l’outil 

d’autoévaluation. Toutefois, compte tenu du temps nécessaire pour ce faire, les 

institutions doivent réfléchir attentivement à l’intérêt d’une telle suppression. 

 Si une institution souhaite ajouter un élément, elle peut le faire en suivant 

les instructions présentées au chapitre 4. Comme pour la suppression, l’ajout de 

contenus nécessite tout d’abord de modifier le référentiel de compétences de l’UE, 

avant de transposer les changements dans l’outil d’autoévaluation, en tenant compte 

des mêmes aspects relatifs aux efforts à déployer et aux avantages de l’ajout. 

Pour les niveaux de maîtrise des compétences: 

 Les niveaux de maîtrise de compétences peuvent également être modifiés 

en suivant les instructions du chapitre 4. Toutefois, ces niveaux se voulant être 

des objectifs à moyen terme pour le développement des compétences et n’étant pas 

utilisés pour l’appréciation de la performance des employés, il est recommandé de ne 

pas les modifier. 

Concernant les orientations destinées aux employés, il existe deux possibilités: 

 la direction peut donner des instructions aux employés en ce qui concerne la 

sélection des tâches, sous-tâches et compétences sur la base des fonctions des 

unités organisationnelles: l’avantage est que les résultats de l’évaluation cibleront 

uniquement les compétences pertinentes, mais l’inconvénient est que cette solution 

ne permet pas de se faire une représentation complète des compétences de 

l’institution; ou 
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 la direction peut permettre aux employés de sélectionner les tâches, sous-tâches et 

compétences: l’avantage est que les résultats donneront une large vision des 

compétences des institutions, avec l’inconvénient que les compétences non 

pertinentes seront également prises en compte; 

 une approche utile pour sélectionner la meilleure option est d’analyser la corrélation 

entre les tâches et sous-tâches du référentiel de compétences de l’UE et les 

responsabilités des unités organisationnelles (voir le graphique ci-dessous): 

Tâches du référentiel de compétences 
Institution 

Unité 1 Unité 2 Unité 3 Unité 4 

1. Programmation     

2. Mise en place du système     

3. Création du projet     

4. Suivi du projet     

5. Suivi du programme     

6. Évaluation     

7. Gestion financière au niveau du projet      

8. Gestion financière au niveau du programme     

9. Communication     

10. Supervision des organismes intermédiaires     

Activité 1.4: préparation des supports de formation et de communication 

Le présent guide de l’utilisateur et les supports promotionnels disponibles sur le site de 

la DG REGIO (brochure et infographie) peuvent être utilisés à des fins de formation et de 
communication internes. Toutefois, si une administration souhaite élaborer d’autres 

supports personnalisés, ou des lignes directrices à l’intention de ses employés, il est 
recommandé de les préparer à ce stade. 

Activité 1.5: définition du plan de travail 

Les phases suivantes peuvent être mises en œuvre sur une période de deux mois. Au 
moment de déterminer la durée et la période de l’autoévaluation, l’institution peut tenir 

compte 1) de la charge de travail des employés et du respect des autres délais de 
l’institution; 2) des liens avec d’autres activités, telles que la préparation des plans de 

formation/de recrutement.  

De même, en tenant compte des contraintes potentielles, l’institution doit déterminer si 

une assistance extérieure est nécessaire pour assurer la réalisation efficace de 
l’évaluation. Si une telle assistance s’avère nécessaire, des ressources financières 

peuvent être dégagées au titre du budget d’assistance technique du programme.  

Un modèle de plan de travail est inclus à l’ANNEXE 2: MODÈLE DE PLAN DE TRAVAIL. 

 Phase 2: déploiement de l’évaluation 3.2

Activité 2.1: formation et communication  

Avant le début de l’autoévaluation, il est conseillé d’effectuer les activités suivantes: 

 Formation des superviseurs: cette activité devrait être effectuée par le 

gestionnaire/gestionnaire des RH et avoir pour but de donner aux superviseurs un 

aperçu de la finalité et des bénéfices des instruments. La formation devrait être 

particulièrement axée sur le rôle joué par les superviseurs dans le contrôle de 

l’autoévaluation des employés, les réunions de discussion et la participation à 
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l’analyse des résultats, lorsque celle-ci est jugée pertinente. Il est conseillé 

d’organiser cette activité sous la forme d’une formation théorique. 

 Activités de communication pour les employés du niveau opérationnel: le but 

est d’informer les employés de la finalité et des bénéfices des instruments ainsi que 

de la manière dont l’évaluation doit être réalisée. S’agissant du format, la 

communication peut être organisée sous la forme d’un événement d’information ou 

en utilisant les canaux numériques de l’institution (par exemple un courrier 

électronique, un séminaire en ligne ou un site web). Dans les petites institutions, un 

événement unique ciblant les superviseurs et les employés peut être organisé. 

 Formation et communication personnalisées: les institutions qui ont choisi de 

fournir des instructions aux employés sur la sélection des tâches, des sous-tâches et 

des compétences peuvent envisager d’organiser des événements distincts pour 

chaque unité organisationnelle. 
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Activité 2.2: début de l’évaluation des compétences 

Le gestionnaire accède à l’outil d’autoévaluation via ce lien1 en utilisant le nom 

d’utilisateur et le mot de passe qu’il a reçus de la DG REGIO. Il s’agit de la section 

d'administration («administration section») de l’outil, qui contient des fonctions 

permettant de lancer l’évaluation, de suivre les réponses et d’analyser les résultats. 
Dans la section «administration», le gestionnaire trouvera le formulaire d’autoévaluation. 

En cliquant sur «Share», le système créera un lien vers l’outil d’autoévaluation que le 
gestionnaire pourra ensuite transmettre aux employés. 

Activité 2.3: autoévaluation par les employés 

En cliquant sur le lien, les employés arriveront sur la page d’accueil de l’outil 
d’autoévaluation. Il leur est recommandé de se familiariser avec les étapes de 

l’évaluation décrites sur cette page avant de commencer.  

La première fois que l’employé accède à l’outil d’autoévaluation, il s’enregistre en tant 
que nouvel utilisateur (section de gauche), en choisissant le nom d’utilisateur et le mot 

de passe de son choix. Les fois 
suivantes, il entrera les mêmes 

informations de connexion, 
mais dans la section 

«Returning User» (à droite). 

 

 

 

 

 

                                          

1 https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools  

https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools
https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools
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L’outil d’autoévaluation génère la liste des compétences à évaluer, selon la logique du 

référentiel de compétences de l’UE, c’est-à-dire sur la base du rôle professionnel, des 
tâches et des sous-tâches.  

Sur le formulaire d’informations de base, l’employé: 

 sélectionne le groupe de rôles professionnels pertinent dans la liste déroulante 

incluant le niveau décisionnel, le niveau de la supervision et le niveau opérationnel; 

 sélectionne, dans la liste des tâches, celles qui sont pertinentes en cochant les cases 

situées en regard de celles-ci. Lorsqu’une tâche est sélectionnée, les sous-tâches 

apparaissent. Les employés du niveau opérationnel doivent examiner la liste des 

sous-tâches et sélectionner celles qui sont pertinentes. Les employés du niveau 

décisionnel et du niveau de la supervision ne sont pas tenus de sélectionner les sous-

tâches. 

 L’employé du niveau opérationnel doit également fournir des informations sur le 

superviseur qui procèdera à l’évaluation de ses compétences et indiquer le titre du 

programme pour lequel l’évaluation est effectuée (cette consigne est importante, vu 

que certains employés peuvent participer à plusieurs programmes opérationnels). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

L’employé procède à une autoévaluation pour la liste de compétences générée: 

 les compétences sont regroupées en trois catégories: les compétences 

opérationnelles, les compétences de gestion et les compétences professionnelles. 

 Les employés évaluent chaque compétence sur la base de l’échelle de maîtrise 

incluse dans l’outil d’autoévaluation. L’échelle va de 0 à 4 et comporte une option 

«Not Applicable» (sans objet) que les employés doivent utiliser dès qu’ils pensent 

qu’une compétence est inutile: l’utilisation de cette option permettra de mieux cibler 

l’évaluation et les activités de développement. 
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Niveau Description de la maîtrise 

N.A. - Not Applicable 
(S.O. - sans objet) 

La compétence ne s'applique pas au rôle professionnel et ne devrait pas 
être évaluée. 

Level 0 - No 

knowledge (Niveau 0 

- Aucune 
connaissance)  

Aucune connaissance de la compétence.  

Aucune aptitude à appliquer la connaissance. 

Level 1 - Awareness 
(Niveau 1 - 

Sensibilisé) 

Connaissance élémentaire de la compétence (par exemple concepts généraux).  

Aptitude élémentaire à appliquer les connaissances aux tâches quotidiennes 

(par exemple, déterminer et étudier différents aspects, comprendre et 

interpréter des documents et situations). 

Level 2 - Trained 
(Niveau 2 - Formé) 

Bonne connaissance opérationnelle de la compétence.  

Capacité à appliquer les connaissances aux tâches quotidiennes (par exemple, 

déterminer les aspects essentiels, proposer des solutions et préparer les 

documents pertinents). 

Level 3 – 
Intermediate 

(Niveau 3 - 
Intermédiaire)  

Connaissance approfondie de la compétence. 

Vaste capacité à appliquer les connaissances dans les tâches quotidiennes (par 

exemple, conseiller les autres, élaborer de nouvelles approches, choisir la 

bonne voie à suivre dans un cadre plus large). 

Level 4 - Expert 
(Niveau 4 - Expert) 

Vastes connaissances et expertise en rapport avec la compétence. 

Capacité à distinguer les (dés)avantages de chacun des processus en rapport 

avec la compétence tout en les rattachant à la vision globale. 

Aptitude à fournir des conseils personnalisés et à accompagner ceux-ci 

d’arguments pertinents et propres au contexte en répondant aux demandes 

internes et externes. 

L’employé est considéré par les autres comme un modèle capable de les diriger 

ou de les former dans le domaine de la compétence 

Une fois l’autoévaluation réalisée pour chaque groupe de compétences, l’employé peut 
fournir des commentaires qualitatifs supplémentaires dans une boîte prévue à cet effet. 

Note: s’il n’y a aucun commentaire, l’employé doit indiquer «No comment» (aucun 
commentaire). 

 

                Note: lorsqu’une section reste vide, un message «error» (erreur) apparaît. 
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À tout moment, l’employé peut interrompre l’autoévaluation au moyen du bouton «SAVE 

PROGRESS» (enregistrer les modifications) au bas de chaque page. Pour revenir à 
l’évaluation, l’employé utilisera le lien enregistré et se connectera en tant qu’utilisateur 

existant (voir l’étape 3). 

 

Une fois que l’employé a rempli son autoévaluation pour toutes les compétences, il est 

notifié de la fin de sa partie du travail et invité à communiquer le nom d’utilisateur et 
mot de passe à son superviseur. 

 

 

Activité 2.4: évaluation des employés par le superviseur 

Le superviseur se connecte à l’outil d’autoévaluation afin d’effectuer l’évaluation des 

compétences de l’employé. Pour ce faire, il se connecte en tant qu’utilisateur existant au 
moyen du nom d’utilisateur et du mot de passe fournis par l’employé. 

Les évaluations du superviseur et de l’employé sont effectuées sur des pages différentes 
de l’outil d’autoévaluation. Après s’être connecté, le superviseur est invité à se rendre à 

la section de l’évaluation qui lui est réservée.  Si les résultats de l’employé sont visibles, 

ceux-ci ne devraient pas être consultés, afin d’éviter tout biais. 
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Le superviseur procède à l’évaluation des compétences de l’employé.  

 

 

 

 

 

 

 

 

 

 

 

La fin de l’évaluation est signalée par une page de séparation. Le superviseur enregistre 
les résultats, puis informe l’employé de la fin de l’évaluation et convient avec lui d’une 

réunion de discussion. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Activité 2.5: résultats de l’évaluation et réunion de discussion  

L’employé et le superviseur se rencontrent afin de discuter des résultats de l’évaluation 

des compétences.  

Il est conseillé d’organiser cette discussion sous la forme d’une réunion en face à face.  

 L’objectif de la discussion est d’analyser les résultats de l’autoévaluation, de recenser 

les points forts et les points à améliorer et de convenir d’actions de suivi en vue du 

développement des compétences. 

 Les résultats de l’évaluation sont présentés en plusieurs parties: l’autoévaluation de 

l’employé, l’évaluation du superviseur et le niveau de maîtrise souhaité prédéfini 

dans l’outil, qui représente l’objectif de développement des compétences à moyen 

terme. 

 En cas de divergence majeure entre l’évaluation du superviseur et celle de l’employé, 

les résultats de l’évaluation devront être ajustés.  
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 Il importe de tenir compte de cet ajustement dans l’évaluation du superviseur, 

puisque celle-ci sera incluse dans les rapports d’évaluation individuels et apparaîtra 

dans le calcul des résultats au niveau de l’institution. 

 

À la fin de la discussion, les conclusions relatives aux points forts et aux points restant à 

améliorer peuvent être saisies dans le système.  
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Le superviseur confirme ensuite que tous les champs ont été correctement remplis et 

clique sur «Next» (Suivant). La page «Submit» (Soumettre) apparaît alors. Une fois que 
le superviseur a cliqué sur «Submit», les résultats ne peuvent plus être modifiés. 

 

 

Activité 2.6: génération des rapports d’évaluation individuels 

Le gestionnaire accède à la zone d’administration de l’outil et clique sur «Results» 

(Résultats). 

 

Sur la nouvelle page qui s’affiche, le gestionnaire peut consulter la liste des évaluations 

individuelles achevées, en regard desquelles se trouve l’indication «statut (status) vert».  

Pour soumettre le rapport d’évaluation individuel, le gestionnaire sélectionne d’abord 

l’individu («Individual») dans la liste déroulante située dans la section en haut à droite 

de la page, puis clique sur l’icône «Enveloppe» située à gauche du nom d’utilisateur de 
l’employé. 
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Sur l’écran «Email result» (Résultat E-mail) qui 

apparaît, le gestionnaire remplit les différents 
champs figurant sur la capture d’écran: 

 Courriel: adresse électronique de l’employé 

 Notification: Custom (personnalisée) 

 Format: Results PDF (résultats PDF) 

 Results PDF (Résultats PDF): Table (Tableau) 

 Results View (Affichage des résultats): 

Individual Report (rapport individuel) 

 Optional message: insérer un message 

(facultatif) 

 Cliquer sur Send (Envoyer) 

 

 

 

 

 

Les résultats de l’évaluation individuelle incluent les trois valeurs discutées au cours de 
la session de retour d’informations entre l’employé et le superviseur, à savoir 

l’autoévaluation, l’évaluation du superviseur et le niveau de maîtrise souhaité. Afin que 
l’évaluation du superviseur soit mise en évidence, le rapport individuel affiche celle-ci 

dans une colonne séparée à droite (voir l’image). 

 

 

Note: les compétences ayant été indiquées comme «Not applicable (N.A.)» (sans objet 
s.o.) par le superviseur apparaissent dans le rapport en tant qu'un nombre entre 

107 et 110. 
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 Phase 3: analyse et préparation du plan d’apprentissage et de 3.3

développement 

Activité 3.1: préparation des analyses au niveau de l’institution 

Le gestionnaire se connecte à l’outil d’autoévaluation et accède à la page «Results» 

(Résultats).  

À partir de cette section, deux types d’analyses au niveau de l’institution peuvent être 
réalisées: celle d’une compétence donnée ou celle de toutes les compétences. 

Analyses de compétences données au niveau de l’institution 

Cliquer sur «Analytics» (Analyse), puis «Item Summary» (Récapitulatif des éléments) et 

sélectionner une compétence dans la liste. Pour la compétence sélectionnée, un tableau 

décrivant la répartition des employés (ayant réalisé une évaluation pour la compétence 
en question) en fonction du niveau de maîtrise évalué par le superviseur est généré.  

Par exemple, dans le tableau ci-dessous relatif à la compétence MA.O.C1 – Actes 
législatifs de l’UE/des États membres relatifs aux fonds ESI, il y a sept employés dont le 

niveau de maîtrise a été évalué à 1, 60 dont le niveau de maîtrise a été évalué à 2 et 
32 dont le niveau de maîtrise a été évalué à 3. 

Il est possible de limiter l’analyse d’une compétence donnée à une tâche en cliquant sur 

«Analytics» (Analyse), puis «Cross-Tabulation». Étant donné qu’une même compétence 
est associée à plusieurs tâches, cette analyse peut par exemple être utile au superviseur 

d’une unité organisationnelle donnée qui souhaite analyser la maîtrise d’une compétence 
spécifique par les employés de son unité. 

Pour ce faire, cliquer sur «Cross-Tabulation», puis, sous «Question A», sélectionner une 
tâche et, sous «Question B», une compétence. Par exemple, le tableau ci-dessous 

présente les résultats de l’évaluation de la compétence MA.O.C1 - Actes législatifs de 

l’UE/des États membres relatifs aux fonds ESI uniquement pour les employés qui 
exécutent la tâche «Monitoring on Programme level» Suivi au niveau des programmes.  

Le tableau détaille les résultats par sous-tâche: ainsi, par exemple, pour la sous-tâche 
«Measurement of the performance of the PA/Measure (planning, monitoring, forecasting, 

revising)» [Mesure de la performance de l’AP/de la mesure (planification, suivi, 
prévision, révision)], il y a un employé ayant un niveau de maîtrise évalué à 1, 

deux employés dont le niveau de maîtrise a été évalué à 2 et un employé dont le niveau 
de maîtrise a été évalué à 3. 
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Analyse de toutes les compétences au niveau de l’institution 

L’objectif est d’obtenir une analyse de toutes les compétences au niveau de l’institution, 
en regroupant les résultats des évaluations individuelles des compétences de tous les 

employés. Pour ce faire, il faut extraire les données brutes (dans Excel) à partir de l’outil 
d’autoévaluation et les coller dans un modèle Excel semi-automatisé [voir le modèle 

d'analyse au niveau de l'institution «Institution_analysis_Template» inclus à l’ANNEXE 4: 
MODÈLES D’ANALYSE AU NIVEAU DE L’INSTITUTION]. 

Deux ensembles distincts de données brutes sont téléchargés, respectivement pour les 

employés opérationnels et les employés non opérationnels (superviseurs et décideurs), 
puis collés dans différentes feuilles de calcul des modèles d’analyse au niveau de 

l’institution. 

 

Les opérations suivantes sont 
effectuées afin de télécharger les 

données brutes: 

 dans le menu de droite de la page 

«Results»(Résultats), cliquer sur 

«Export» (Exporter) 

 Dans le menu déroulant «Results 

View» (Afficher les résultats), 

sélectionner «Institution Report» 

(Rapport sur l’institution)  

 Dans «Results Filter» (Filtrer les 

résultats), sélectionner 

«Operational» (Opérationnel) pour 

les données relatives aux employés 

du niveau opérationnel et «Non-

Operational» (Non opérationnel) 

pour les données relatives à tous les 

autres employés. 

 Cliquer sur le bouton vert «Export» (Exporter) pour télécharger les résultats au 

format Excel. 

 Pour recevoir les résultats par courrier électronique, cliquer sur «Email me» (Recevoir 

un courriel), indiquer l’adresse de courrier électronique et cliquer sur «Export». 
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Une fois que les fichiers Excel pour les employés 

opérationnels et non opérationnels ont été reçus: 

 Enregistrer les fichiers Excel. 

 Ouvrir chaque fichier et copier les résultats en 

cliquant sur la cellule A1 et en appuyant sur les 

touches CTRL+SHIFT+  +  du clavier.  

 Coller les données copiées dans la feuille de 

calcul correspondante du modèle Excel semi-

automatisé. 

 En collant les données brutes dans le modèle, 

deux rapports d’évaluation de l’institution sont générés.  

La première analyse présente, pour chaque compétence évaluée, le nombre total 

d’employés chez lesquels la compétence a été évaluée, ainsi que leur répartition en 
fonction de l’évaluation du superviseur. Si cette analyse permet de disposer d’un aperçu 

clair du niveau global de développement des compétences au sein de l’institution, elle ne 
donne aucune information sur les objectifs de développement à moyen terme des 

employés, ce qui complique la détermination des mesures de développement les plus 

adéquates. 

 

Le deuxième type d’analyse est plus complet, puisqu’il tient compte du fait que le niveau 
de maîtrise souhaité peut varier en fonction de la sélection des tâches et des sous-tâches 

effectuée par les employés. Dès lors, la répartition des employés en fonction du niveau 
de maîtrise évalué2 tient compte du niveau de maîtrise souhaité pour chaque employé.  

 

Ainsi, dans l’exemple du graphique ci-dessus, au total, six employés devraient afficher 
un niveau de maîtrise souhaité de 2 pour la compétence opérationnelle «MA.O.C43 

Knowledge of Engineering relevant for the sector» (MA.O.C43 Connaissances en 
ingénierie pertinentes pour le secteur). Parmi ces six employés, trois ont déjà atteint 

l’objectif de développement à moyen terme et trois l’ont déjà dépassé. 

Activité 3.2: analyse des résultats et hiérarchisation des actions  

                                          

2 Comme ci-dessus: le niveau de maîtrise évalué par le superviseur pour les employés du niveau opérationnel 

et le niveau de maîtrise évalué par le décideur pour les superviseurs. 

Assessed  level 

0

Assessed level 

1

Assessed  level 

2

Assessed  level 

3

Assessed  level 

4

MA.O.C39
ESIF EU/ National legal acts - 

communication
0 0 0 0 0 0

MA.O.C40
Identification of different stakeholders 

and their information needs
0 0 0 0 0 0

MA.O.C41 Management of relevant media 0 0 0 0 0 0

MA.O.C42 Web communication 0 0 0 0 0 0

O
p
e
ra

ti
o
n
a
l

Competencies
Total 

assessed 

employees

Number of employees by supervisor assessed proficiency level

0 1 2 3 4 0 1 2 3 4 0 1 2 3 4 0 1 2 3 4

MA.O.C41 Management of relevant media 2 0 0 0 0 0 2 0 0 0 0 0 0 0 0 0 N/A N/A N/A N/A N/A

MA.O.C42 Web communication 0 0 0 0 0 0 N/A N/A N/A N/A N/A 0 0 0 0 0 N/A N/A N/A N/A N/A

MA.O.C43
Knowledge of Engineering relevant 

for the sector
11 N/A N/A N/A N/A N/A 0 0 3 3 0 0 1 3 1 0 N/A N/A N/A N/A N/A

MA.O.C44
Audit standards, procedures and 

methodologies
0 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A 0 0 0 0 0 N/A N/A N/A N/A N/A

Competencies
Desired level 1

O
p
e
ra

ti
o
n
a
l

Desired level 2 Desired level 3 Desired level 4

Number of employees by sypervisor assessed proficiency level

Total 

assessed 

employees
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L’objectif est de recenser les compétences que les institutions entendent améliorer et de 

déterminer comment procéder, sur la base des éléments factuels inclus dans les 
analyses des évaluations de l’institution.  

Pour cette activité, la participation active de la direction de l’institution est essentielle. 
L’activité nécessite une connaissance approfondie de l’institution et du contexte du cycle 

de vie de la programmation (par exemple situation actuelle, activités planifiées et défis à 
relever). 

Il n’existe aucune approche unique ou méthode universelle pour la hiérarchisation des 
compétences. Il est recommandé de procéder à une analyse systématique des résultats 

pour toutes les compétences et de sélectionner celles qui doivent être développées. 

Une fois ces compétences recensées, l’étape suivante est de sélectionner l’approche la 
plus appropriée pour assurer leur développement. Les possibilités existantes incluent la 

formation, le recrutement, l’externalisation (utilisation d’une expertise extérieure), 
l’automatisation robotisée des processus ainsi que la participation à des réseaux 

d’apprentissage et les enseignements tirés de bonnes pratiques, notamment via 
l’apprentissage par les pairs.   

Afin de faciliter la sélection des méthodes et actions de développement des 
compétences, un cadre méthodologique a été élaboré et est présenté dans le graphique 

ci-dessous: 

 

Les principes du cadre méthodologique sont résumés comme suit: 

 La formation est l’option privilégiée pour le développement des 

compétences. Le choix de la méthode de formation la plus appropriée doit tenir 

compte du niveau de maîtrise à atteindre. Les niveaux de maîtrise élevés sont 

associés aux méthodes favorisant l’interactivité. Dans ce cadre, la référence 

théorique est la taxonomie des acquis d’apprentissage élaborée par Bloom: 

Méthode 

d’apprentissage 
Définition 

Pour atteindre un niveau de compétence 3 ou 4 

Programmes 

d’apprentissage basés 

sur l’intervision 

L’intervision est une méthode d’entraide entre pairs ou collègues afin de 
s’aider mutuellement à traiter les problèmes rencontrés par chaque 

personne dans l’exercice de ses fonctions. Un modérateur est parfois 
disponible.  

Niveau 1

Niveau 2

Niveaux 3 -
4

Méthodes 
d’apprentissage

ExternalisationRecrutement Automatisation

Apprentissage 
en milieu 

professionnel, 
présentations, 

séminaires

Seulement si 
aucun employé 
ne possède la 
compétence

Formation en 
classe ou 
virtuelle

Formation sur 
le lieu de 
travail, 

mentorat, etc.

Solution la plus 
adaptée à ces 

niveaux. 
Faible niveau 
actuel et forte 

urgence. 

À n’utiliser 
qu’en cas de 
faible niveau 
actuel et de 

forte urgence

Réseaux

Forte urgence 
de développer 

les compétences 
relatives à une 
tâche donnée

Accompagné 
d’un 

apprentissage 
au niveau 
interne.

Déconseillé à 
long terme pour 

les tâches 
stratégiques.

Conserver/dével
opper les 

capacités de 
supervision de 

l’externalisation

Limité à 
certaines 
activités 

répétitives au 
niveau des 

sous-tâches.

Utilisé en 
substitution 

d’une 
externalisation

.

Conserver/déve
lopper les 

capacités de 
supervision de 

l’externalisation
des tâches 

automatisées.

Niveau de 
maîtrise à 
atteindre

Bonnes pratiques

Actions les plus 
recommandées À envisager

Actions moins 
appropriées

Sélection d’actions
En complément des 

autres
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Méthode 

d’apprentissage 
Définition 

Apprentissage sur le 

terrain 

Une approche individuelle d’«apprentissage par la pratique» dans le cadre de 

laquelle l’employé acquiert de nouvelles compétences dans une situation de 

travail ordinaire. L’employé reçoit des retours d’informations directs tout en 

exécutant ses tâches. La personne qui encadre l’employé l’observe, lui donne 

des instructions et lui fait part de ses commentaires.  

Encadrement et aide à 

la performance 

Un soutien individuel apporté sur le lieu de travail en ce qui concerne des 

problèmes fonctionnels d’ordre technique ou personnel. Ce soutien est disponible 

au niveau interne (dispensé par un gestionnaire ou une autre personne de 

l’organisation) ou au niveau externe (coach externe). 

Discussion modérée 

avec la participation 

d’experts 

Un événement au cours duquel les employés ont la possibilité d’aborder les 

problèmes techniques qu’ils rencontrent au travail et de recevoir des conseils, 

des astuces pratiques et des solutions à ces problèmes. 

Pour atteindre un niveau de compétence 2 

Travaux en classe 

(virtuelle) 

Un groupe d’employés qui souhaitent en apprendre davantage sur certaines 

compétences. Ils peuvent se rassembler physiquement dans un espace ou se 

rencontrer virtuellement.  

Travaux de groupe Un groupe d’employés reçoit un travail à accomplir collectivement. 

Ludification interactive 

La ludification interactive est le processus consistant à appliquer des modèles et 

des concepts de jeu à des formations afin de les rendre plus attrayantes pour 

l’apprenant. Les participants jouent directement contre une ou plusieurs 

personnes ou participent individuellement à une expérience interactive 

récompensant d’une certaine manière les performances d’apprentissage. 

Pour atteindre un niveau de compétence 1 

Apprentissage en ligne 

Un fichier exécutable d’apprentissage qui peut être envoyé par courrier 

électronique et utilisé de manière autonome sur un PC ou chargé sur une 

plateforme d’apprentissage en ligne dûment configurée. Cette méthode permet 

d’apprendre à son rythme au moyen de contenus textuels, de graphiques 

statiques, d’animations et d’interactions périodiques pour plus de motivation et 

de mémorisation. 

Présentation 

engageante  

Une méthode interactive permettant d’engager un groupe de personnes dans 

une discussion autour d’un thème. Cette méthode peut prendre la forme d’une 

discussion, d’un débat, d’un récit, d’une session de questions et réponses, etc.  

Pour l’organisation de la formation, deux possibilités sont envisageables, à savoir la 

participation à des événements de formation existants ou l’organisation d’événements 
sur mesure pour l’institution. Le choix doit être effectué en tenant compte du rapport 

qualité-prix, basé 1) sur la pertinence de la formation et 2) sur son coût (personnes à 
former * coût de la formation par participant). 

 Le recrutement est conseillé lorsque le niveau actuel de développement d’une 

compétence est faible par rapport au niveau souhaité et qu'il existe un besoin urgent 

de combler ce déficit. Le recrutement doit être envisagé essentiellement pour 

internaliser des ressources possédant un niveau de maîtrise de 3 ou 4 afin de 

répondre à un besoin spécifique de compétences impossible à combler rapidement 

par la formation. 

 L’externalisation, qui se veut être le recrutement d’expertise externe afin de 

répondre à des manques de compétences spécifiques, doit toujours être envisagée 

en corrélation avec une ou plusieurs tâches ou sous-tâches. Pour les tâches 

stratégiques, l’institution peut envisager de n’avoir recours à l’externalisation qu’en 

tant que solution temporaire, jusqu’à ce que les compétences internes soient 

suffisamment développées. Il est également conseillé d’inclure les activités de 

développement des compétences dans les projets d’externalisation. Pour les tâches 

non stratégiques, l’externalisation peut être envisagée en tant que solution à long 

terme, mais un niveau minimal de compétence devrait également être développé au 

sein de l’institution. 

 L’automatisation robotisée des processus est l’introduction de logiciels sur 

mesure pour l’exécution de sous-tâches répétitives. Compte tenu des critères d’e-

cohésion relatifs à l’échange de données informatisées et de la nature des sous-
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tâches, l’automatisation robotisée des processus pourrait trouver une application 

dans le cadre d’aspects spécifiques de l’évaluation des projets, des contrôles 

administratifs et de l’admissibilité et de la vérification des demandes de paiement. Un 

cas d’usage devrait être élaboré afin d’évaluer au préalable le potentiel d’application 

concrète; par conséquent, les institutions ne devraient pas envisager cette option 

pour répondre à leurs besoins de compétences les plus urgents. 

 Participation à des réseaux d’apprentissage: il existe un certain nombre de 

réseaux d’apprentissage en rapport avec les compétences, établis au niveau 

européen et exploités soit par la Commission, soit par des établissements 

universitaires3. La participation à ces réseaux devrait être considérée comme une 

possibilité d’apprentissage complémentaire à celles présentées ci-dessus. 

 Bonnes pratiques: De bonnes pratiques en matière de développement des 

compétences sont disponibles sur le site de la DG REGIO4. Comme pour la 

participation aux réseaux d’apprentissage, l’adoption de bonnes pratiques, y compris 

via l’apprentissage par les pairs, devrait être envisagée en tant que possibilité 

d’apprentissage complémentaire. 

Comme réalisation de cette activité, il est recommandé d’ajouter au «modèle d’analyse 
au niveau de l’institution» la liste des compétences à améliorer sélectionnées ainsi que la 

méthode d’apprentissage retenue, en indiquant un calendrier dans la mesure du 
possible. La liste sera ensuite présentée à un plus large groupe de parties prenantes de 

l’institution, comme décrit dans l’activité suivante: 

Code Compétence 

Total des 

employé
s 

évalués 

Niveau 

évalué 
1 

Niveau 

évalué 
2 

Niveau 

évalué 
3 

Niveau 

évalué 
4 

Sélectionnées 

pour 
développemen

t 

Méthode de 

développemen
t des 

compétences 

Calendrie
r 

MA.O.C
1 

Actes législatifs de 
l’UE/des États membres 

relatifs aux fonds ESI  
     OUI Formation T3(2018) 

MA.O.C
2 

Documents stratégiques 

nationaux (p.ex. 

stratégies 

nationales de 

développement
, politiques 

thématiques et 
sectorielles 

pertinentes) 

    

 

   

MA.O.C

3 

Dispositions des actes 
législatifs, lignes 

directrices et 
méthodologies de 

l’UE/des États membres 
relatives à l’admissibilité 

des dépenses, y compris 
étendue du soutien 

    

 

   

 

Activité 3.3: atelier de discussion des résultats  

Cette activité a pour but de partager les résultats de l’évaluation des compétences et des 
actions de développement des compétences planifiées avec un plus vaste groupe de 

parties prenantes de l’institution, ainsi que d’obtenir l’approbation du décideur.  

Les écoles nationales d’administration publique peuvent participer à cet atelier afin de 

faciliter le recensement des possibilités de formation répondant aux besoins des 

institutions. 

 

                                          

3 http://ec.europa.eu/regional_policy/sources/docgener/studies/pdf/comp_fw/eu_comp_fw_report_en.pdf 
4 http://ec.europa.eu/regional_policy/sources/docgener/studies/pdf/comp_fw/eu_comp_fw_annex7_en.pdf 



 

29 

Activité 3.4: préparation du plan d’apprentissage et de développement 

À la fin de l’évaluation, il est recommandé aux institutions de préparer un plan 
d’apprentissage et de développement synthétisant les résultats de l’évaluation ainsi que 

les actions de suivi prévues pour le développement des compétences. 

Il est recommandé de faire correspondre la planification des ressources au titre du 

budget d’assistance technique du programme opérationnel géré/mis en œuvre par 

l’institution aux activités incluses dans le plan d’apprentissage et de développement. Le 
modèle de plan d’apprentissage et de développement est inclus à l’ANNEXE 3: MODÈLE 

DU PLAN D’APPRENTISSAGE ET DE DÉVELOPPEMENT et couvre: 

 la portée et la méthodologie de l’autoévaluation; 

 les résultats de l’évaluation des compétences au niveau de l’institution; 

 les actions immédiates à entreprendre pour développer les compétences: méthodes 

d’apprentissage sélectionnées et actions visant à combler les manques de 

compétences ainsi que le calendrier de mise en œuvre; 

 une réflexion sur la manière d’utiliser l’outil à l’avenir, en abordant les aspects relatifs 

à la responsabilité, les procédures de mise en œuvre et les besoins de ressources; 

 une feuille de route de mise en œuvre pour les actions immédiates et la préparation 

de leur utilisation future. 

Lors de la préparation du plan, les institutions peuvent également mener une réflexion 

sur la pertinence d’envisager des adaptations à la structure organisationnelle en fonction 
de la liste des tâches et sous-tâches incluse dans le référentiel de compétences de l’UE. 

Cela permettrait de mieux comprendre la répartition des rôles et responsabilités entre 
les unités organisationnelles. 
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 COMMENT PERSONNALISER LES INSTRUMENTS 4

 Personnaliser le référentiel de compétences de l’UE 4.1

Si une institution souhaite personnaliser les instruments, il lui est recommandé de 
commencer par documenter tous les changements dans la version Excel du référentiel 

de compétences de l’UE.  

 

Concrètement, la personnalisation du référentiel suppose les étapes suivantes: 

 pour l’ajout d’une nouvelle tâche: la première étape consiste à détailler les sous-

tâches, puis à associer les compétences nouvelles et existantes et à attribuer les 

niveaux de maîtrise, pour tous les rôles professionnels. 

 pour l’ajout d’une nouvelle sous-tâche: la première étape consiste à associer les 

compétences nouvelles et existantes et à attribuer les niveaux de maîtrise, pour tous 

les rôles professionnels. 

 pour l’ajout d’une nouvelle compétence: celle-ci doit être associée aux sous-tâches 

existantes pour les employés du niveau opérationnel ainsi qu’aux autres rôles 

professionnels. 

 Si les niveaux de maîtrise doivent être modifiés, il suffit de remplacer les niveaux 

existants par les nouveaux. 

 Il est également recommandé d’activer le suivi visuel des modifications dans le 

fichier. 

 Personnaliser l’outil d’autoévaluation 4.2

4.2.1 Comment ajouter/modifier des tâches 

Exigences 

 Accès du gestionnaire à l’outil d’autoévaluation 

 Référentiel de compétences de l’UE 

 

 

Preparation of the 

Programme 

Definition of the 

guiding principles 

for selection of 

operations 

Management of 

the evaluation 

process (ex-ante)

NEW SUB-TASK
Negotiation with 

the EC

Procurement of 

goods and 

services under 

Technical 

Assistance

MA.O.C1 ESIF EU/  Nat ional legal acts - general 4 4 2 4 2 3 3

MA.O.C2

Nat ional st rategic documents (e.g. Nat ional 

Development  St rategies, relevant  themat ic 

and sectoral policies)

4 4 2 4 1 3 3

NEW COMPETENCY

NEW 

PROFICIENCY 

LEVEL

MA.O.C3

ESIF EU/  Nat ional legal acts - eligibilit y of 

expenditure (rules, guidelines and 

methodologies, including the scope of 

support )

4 2 4 3 3 3

MA.O.C4

Territorial issues, such as ITI, CLLD, 

Sustainable urban development , 

macro/ regional st rategies and interregional 

cooperat ion planning

3 2 3 3 2

Operat ional Competencies

Operat ional level

Supervisory level
Decision making 

level

Programming
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Instructions 

1. Connectez-vous à Formsite et cliquez sur le bouton «Edit» du formulaire de votre 

institution 

2. Placez le curseur sur la boîte «Tasks» (tâches) et cliquez sur «Edit» (Modifier) en bas 

à gauche 

3. Sous «Edit Choices» (Modifier les choix), cliquez sur le cercle «+» pour ajouter une 

nouvelle tâche OU cliquez sur le crayon pour modifier le nom d’une tâche 

4. Cliquez sur le bouton vert «Save» (Enregistrer) en bas de la fenêtre.  

5. La tâche ajoutée/modifiée apparaîtra sur le formulaire  

Note: si aucune sous-tâche ne doit être ajoutée, passez à l’étape 11. 

6. Pour ajouter une nouvelle liste de sous-tâches, dans le menu «Common Items» 

(Éléments communs) à gauche, cliquez et déplacez une «Checkbox» (case à cocher) 

n’importe où sous le titre «Subtasks» (Sous-tâches). 

7. Dans la fenêtre «Checkbox» (Case à cocher), sous «Choices» (Choix), cliquez sur 

«Choices» (Modifier les choix). Cliquez ensuite sur «+» pour ajouter une sous-tâche 

ou supprimez le texte «Choice A» ou «Choice B» pour nommer les sous-tâches 

supplémentaires. 

8.  Une fois que toutes les sous-tâches ont été ajoutées, cliquez sur le bouton vert 

«Save» (Enregistrer) en bas de l’écran.  

9. Passez le curseur sur la boîte «Added text» (Texte ajouté) et cliquez sur «Edit» 

(Modifier). 
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10. Dans la barre supérieure, cliquez sur «Rules» (Règles). Parmi les options de la liste 

déroulante du dessous, choisissez «Tasks» «is» (est égal à) et «Added task 

example» (exemple de tâche ajoutée) (vous définirez ainsi une «règle» selon laquelle 

cette case n’apparaîtra que lorsqu’«exemple de tâche ajoutée» sera sélectionné dans 

le menu «Tasks»). 

11. Pour déterminer les compétences liées aux nouvelles sous-tâches, vous devrez 

définir les «règles» pour chacune des compétences. Pour ce faire, faites défiler 

l'écran jusqu'à la page 3, placez le curseur sur les compétences que vous souhaitez 

ajouter aux nouvelles tâches et sous-tâches et cliquez sur «Edit» (Modifier). 

12. Dans la barre supérieure, cliquez sur «Rules» (Règles). Ajoutez une nouvelle règle en 

cliquant sur le bouton «+» vert et sélectionnez la règle souhaitée [dans notre 

exemple, MA.O.C5 apparaîtra lorsqu’«added task example» (exemple de tâche 

ajoutée) est égal à «subtask 1» (sous-tâche 1)].  

13. Répétez la procédure pour toutes les compétences concernées dans la section «Self-

assessment» (Autoévaluation).  

14. Pour ajouter une évaluation du superviseur, faites défiler la page jusqu’à la section 

«Self-assessment» (Autoévaluation) et répétez la même procédure pour les 

compétences sélectionnées à l’étape précédente. 

15. Pour déterminer le niveau souhaité pour chaque compétence, faites défiler vers le 

bas jusqu’à la page des résultats (9) et sélectionnez le niveau souhaité pour chaque 

compétence. Exemple: Si la sous-tâche 1 nécessite un niveau de maîtrise 3 pour la 

compétence MA.O.C5 - Aides d’État, placez le curseur sur la boîte adéquate et cliquez 

sur «Edit» (Modifier). 
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16. Dans la barre supérieure, cliquez sur «Rules» (Règles), ajoutez une nouvelle règle en 

sélectionnant l’option adéquate dans le menu déroulant et cliquez sur «Save» 

(Enregistrer). 

17. Répétez la procédure pour chacune des compétences ajoutées et leur niveau de 

maîtrise souhaité. 

Note: si vous voulez modifier une tâche/sous-tâche, rappelez-vous que chacune d’elles est 

«liée» à une série donnée de compétences, comme indiqué dans la feuille de calcul Excel 
du référentiel de compétences de la DG REGIO. Si vous souhaitez adapter la tâche 

modifiée aux nouvelles exigences, veillez à modifier également les compétences «liées». 

4.2.2 Comment modifier les niveaux de maîtrise souhaités 

Supposons, par exemple, qu’un employé exécutant la sous-tâche «Preparation of the 
program» (Préparation du programme) [incluse dans la tâche «Programmation» 

(Programmation)] possède un niveau de maîtrise souhaité de 3 pour la compétence 

MA.O.C5 - Aides d’État. Si vous décidez que le niveau de maîtrise de cette compétence 
devrait être 2 et non 3, suivez les instructions ci-dessous pour effectuer les changements 

nécessaires.   

Exigences 

1. Accès à la page Formsite de l’institution pour le gestionnaire 

2. Référentiel de compétences de l’UE 

Instructions 

1. Connectez-vous à Formsite et cliquez sur le bouton «Edit» du formulaire de votre 

institution 

2. Faites défiler vers le bas jusqu’à la page des résultats (page 9), placez le curseur sur 

la boîte correspondant au niveau souhaité 3 pour la compétence MA.O.C5 et cliquez 

sur «Edit» (Modifier). 

3. Dans la barre supérieure, cliquer sur «Rules» (Règles). 

4. Choisissez la «règle» que vous souhaitez modifier et cliquez sur «-» pour la 

supprimer, puis cliquez sur le bouton «Save» (Enregistrer) vert en bas de la page. 

5. Pour «relier» le niveau souhaité 2 pour la compétence MA.O.C5 à la sous-tâche 

concernée, placez le curseur sur la case correspondant au niveau souhaité 2 pour la 

compétence MA.O.C5, puis cliquez sur «Edit» (Modifier). 
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6. Dans la barre supérieure, cliquez sur «Rules» (Règles), puis cliquez sur le «+» à côté 

de n’importe quelle «règle» pour ajouter la «règle» souhaitée. 

7. Ajoutez la nouvelle règle en sélectionnant les options adéquates dans le menu 

déroulant [(dans notre exemple, «Programming» (Programmation) est égal à 

«Preparation of programme» (Préparation du programme)] et cliquez sur «Save» 

(Enregistrer).  

       

4.2.3 Ajouter des compétences   

Exigences 

 Accès à la page Formsite de l’institution pour le gestionnaire  

 Référentiel de compétences de l’UE 
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Instructions 

1. Ajoutez la compétence en question au référentiel de compétences de l’UE 

2. et déterminez les niveaux souhaités pour les sous-tâches concernées, selon ce que 

vous avez décidé. 

3. Connectez-vous à Formsite et cliquez sur le bouton «Edit» du formulaire de votre 

institution 

4. Faites défiler vers le bas jusqu’aux pages relatives à l’autoévaluation (compétences 

opérationnelles/de gestion/professionnelles), placez le curseur sur la dernière 

compétence de cette catégorie puis cliquez sur «Copy» (Copier). 

5. Placez le curseur sur la compétence copiée et cliquez sur «Edit» (Modifier). 

6. Modifiez le nom de la compétence pour y indiquer le nouveau nom (image de droite). 

 

7. Dans la barre supérieure, cliquez sur «Rules» (Règles) et utilisez les signes «-» et 

«+» pour ajouter ou supprimer les sous-tâches adéquates à la nouvelle compétence 

(selon les valeurs que vous avez ajoutées au référentiel de compétences de l’UE). 
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8. Cliquez sur le bouton vert «Save» (Enregistrer).  

9. Placez le curseur au-dessus de la nouvelle compétence ajoutée et cliquez sur «Copy» 

(Copier).  
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10. Cliquez, glissez et déposez la compétence copiée dans la section correspondante de 

l’évaluation du superviseur (deux pages plus bas).  

11. Pour définir le niveau souhaité pour la nouvelle compétence ajoutée, faites défiler la 

page jusqu’à la catégorie correspondant à la compétence dans la section des 

résultats (compétences opérationnelles/de gestion/professionnelles, pp. 9 et 10).  

12. Placez le curseur sur la boîte du dernier résultat de la page et cliquez sur «Copy» 

(Copier). 

13. Passez le curseur sur la boîte du résultat copié et cliquez sur «Edit» (Modifier). 

14. Modifiez les informations sur la compétence, y compris le niveau de maîtrise 

souhaité, afin qu'elles correspondent à la nouvelle compétence ajoutée. 

15. Dans la barre supérieure, cliquez sur «Rules» (Règles), puis cliquez sur le «+» à côté 

de n’importe quelle «règle» pour ajouter la «règle» souhaitée. 
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16. Dans la barre supérieure, cliquez sur «Rules» (Règles) et utilisez les signes «-» et 

«+» pour ajouter ou supprimer les sous-tâches adéquates àe la nouvelle compétence 

(selon les valeurs que vous avez ajoutées au référentiel de compétences de l’UE).  

Note: Si vous choisissez de modifier le nom d’une compétence existante, n’oubliez pas de 
vérifier les niveaux de maîtrise souhaités qui y correspondent dans la section des résultats et 

de les adapter en conséquence. 



Guide de l’utilisateur pour le référentiel de compétences de l’UE et l’outil d’autoévaluation 
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ANNEXE 1: RÉFÉRENTIEL DE COMPÉTENCES DE L’UE 

Voir fichiers séparés 

1a Référentiel de compétences pour l’organisme de coordination 

1b Référentiel de compétences pour l’autorité de gestion et l’organisme 

intermédiaire 

1c Référentiel de compétences pour le secrétariat conjoint 

1d Référentiel de compétences pour l’autorité de certification 

1e Référentiel de compétences pour l’autorité d’audit 

 

 



Guide de l’utilisateur pour le référentiel de compétences de l’UE et l’outil d’autoévaluation 
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ANNEXE 2: MODÈLE DE PLAN DE TRAVAIL 

Statut:    

    

 
  

    
              Phase  Tâches 

Mois 1 Mois 2 Mois 3 

S1 S2 S3 S4 S1 S2 S3 S4 S1 S2 S3 S4 

Phase 1: mise 

en place 

Activité 1.1: désignation de l’équipe 

de mise en œuvre 
                        

Activité 1.2: formation de l’équipe de 

mise en œuvre 
                        

Activité 1.3: détermination de la 
participation des employés et 
personnalisations éventuelles 

                        

Activité 1.4: préparation des supports 
et modèles 

                        

Activité 1.5: définition du plan de 
travail 

                        

Phase 2: 
Autoévaluation 

Activité 2.1: formation et 
communication  

                        

Activité 2.2: début de l’évaluation des 
compétences 

                        

Activité 2.3: autoévaluation par les 
employés 

                        

Activité 2.4: évaluation des employés 
par le superviseur 

                        

Activité 2.5: résultats de l’évaluation 
et réunion de discussion 

                        

Activité 2.6: génération des rapports 
d’évaluation individuelle 

            

Phase 3: 
analyse et 
préparation du 
plan 

d’apprentissage 
et de 
développement 

Activité 3.1: préparation des analyses 

au niveau de l’institution 
                        

Activité 3.2: analyse des résultats et 
hiérarchisation des actions  

                        

Activité 3.3: atelier de discussion des 
résultats  

                        

Activité 3.4: préparation du plan 

d’apprentissage et de développement 
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ANNEXE 3: MODÈLE DU PLAN D’APPRENTISSAGE ET DE 

DÉVELOPPEMENT 

Voir fichier séparé 
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ANNEXE 4: MODÈLES D’ANALYSE AU NIVEAU DE L’INSTITUTION 

 

Voir fichiers séparés 

1a Modèle d’analyse pour l’organisme de coordination 

1b Modèle d’analyse pour l’autorité de gestion et l’organisme intermédiaire 

1c Modèle d’analyse pour le secrétariat conjoint 

1d Modèle d’analyse pour l’autorité de certification 

1e Modèle d’analyse pour l’autorité d’audit 



 

              doi:[number] 
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